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PREFACE 
The world of trading is complex.  Its mysteries cannot be learned in an afternoon.  The fact 
that you are reading this suggests that you are interested in this area.  Welcome.   

You have many things to learn:  what products are available to trade,  how much of your 
hard earned resources are you going to allocate to the trade, how to evaluate the actions of 
the market and their possible impact on your trading, which strategy is “best” at the 
moment, how to wait patiently, scan for trades that meet your criteria, set alerts, evaluate 
it with various analysis tools for the risks and the rewards, and enter the trade while setting 
parameters for exiting your position.  This is a formidable challenge and you should keep an 
active traders log to help you    These are all part of what is known as a trading plan.  Only 
those with a plan, patience, practice, perspiration, and perseverance will prosper.  

Your education could come from a variety of sources: there are chatrooms Monday through 
Friday, set up for various styles of trading, and afterhour seminars usually starting around 
4;15  ET.  For years, a Wednesday chat session has instructed clients on various trading 
strategies and analytical tools.  Many of these are archived and accessible through the help 
page.  Wherever you come from, whatever your background, realize that help is a 
mouseclick away through the Live Support connection. 

Thankfully, you have a powerful tool, this platform, to assist you.  Thinkorswim has  been 
on a mission since its formation to develop a trading platform that is second to none.  We 
envisioned a platform that could be useful to the individual investor and the trading 
professional for all types of trading:  stocks, options, futures, and foreign exchange,  This is  
just one component of your trading education. 

We have succeeded as verified by Barron’s magazine for the past three years.  Yet,  we are 
not satisfied  to rest on our accomplishments.  The pursuit of excellence is a constant 
journey.  To that end, we listen to our clients request for various features, evaluate them 
for feasibility and added functionality.  There is a team of dedicated programmers who 
convert ideas into reality.  About ten times a year, there are new rollouts of improved 
software.  While adding power to the end user, it also adds complexity and bewilderment to 
someone new to the platform.   

To become really proficient at any software requires a lot of time.  There are obvious basic 
moves and subtle shortcuts to allow one to fly around the platform at dazzling speed.  The 
purpose of this tutorial is to give you the basics and to direct you on where to find the new 
features. 

Should you have any comments regarding this tutorial, please forward them 
to support@thinkorswim.com.   
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Overview of the thinkDesktop Trading Platform 
Welcome to thinkorswim’s thinkDesktop trading platform. This is commonly referred to as 
the ‘software’ platform since it is downloaded to your computer. You’ll notice there are 
several sections of this platform, each designed to give you the most complete, robust 
trading experience available.  

This manual is designed to give you an overview of the basic features of the platform. As 
thinkorswim rolls out new features and tools on a monthly basis, it’s important to first 
understand the logic of the platform and then build on those basics to build your familiarity 
of the platform. Once you are comfortable with the basics, by all means explore the 
advanced features of the platform to enhance your trading. 

This manual will begin in a sequence that we believe is logical from signing in to viewing 
account information and entering orders. The PaperMoney simulation was designed to give 
you an avenue to practice using the platform before you risk making a mistake with your 
own funds. We urge you to experiment with the PaperMoney simulation to get the hang of 
using the platform. You have nothing to lose by 
practicing with this tool and it can always be reset so 
go nuts!  The laws of paperMoney are set out at the 
end of this manual along with some quick references 
regarding shortcut features. 

In addition to this manual, instructional videos are 
provided for you in the learningCenter.  They  
showcase the features of the platform as well as 
display examples of orders which you may find helpful 
(click here or the image to launch).   The videos and 
this text are intended to compliment each other.  
Hopefully, they will also meet the learning styles of each of you.   Auditory visual learners 
may want to go directly to the learningCenter and click on each of the tabs to explore the 
various features.   Other learners may need to learn by reading and even putting notes in 
margins.  You may print up as much of this manual as you feel is necessary to meet you 
needs. 

 

Please note: Despite our best efforts to keep this manual complete and comprehensive, 
there may be points which you feel need further clarification. Feel free to contact our Trade 
Desk for additional information or details prior to placing any trades so that proper 
execution of a desired position can be ensured.   
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I. Setting Start Options 
By opening the options menu, you are able to choose the background color and the size of 
the font you are most comfortable with. 

 

 

Please do not adjust anything in this window other than Color Scheme or Font Size unless 
you are instructed to do so by a TOS Tech Support representative.  

 

Be careful about changing your Font size as too large of a font may disrupt the software’s 
formatting.  This could cause some items to lie beyond the viewing edge of your monitor. 

Once you have made your viewing selections, you can click ‘Save’ to return to the logon 
window. You probably won’t need to visit this window often.  Should your settings not be 
saved, please contact Support@thinkorswim.com. 

Live Trading VS. paperMoney:  

You can connect to Live Trading,  and paperMoney or both.    As trading can involve 
substantial risk involving large sums of money, paperMoney is recommended until you are 
comfortable with the trading platform and preferably have developed a trading plan.  In 
paper, you can experiment without damaging your financial well being. 

Notice the top row of fields is the ‘Connect to’ feature. From this section by left clicking, you 
can choose to sign into Live TOS trading to access your real live account, or you can choose 
‘paperMoney’ to sign into your virtual or fake money account.   

 

 



 

 

 

  

To select between these choices, simply Left Click on your preferred login. You can have 
Live Trading and PaperMoney both open and running simultaneously.  To minimize accidents, 
you will have to click to shift from one mode to the other.  

II. Logging into thinkDesktop  
You are almost ready to enter the platform.  In the upper right hand corner of the login box 
is a “Account with field.  You need to indicate which account you are using:  thinkorswim Inc, 
Investools, or ….  You will be able to logon in live trading and paper for each eligible acct . 

Sign in with your case sensitive username and password.  The same information works for 
Live trading or PaperMoney.    

Quick Tip:  Those of you having multiple accounts can contact support to have them linked 
together and use a single logon.   

 

Quick Shortcuts 

The thinkDesktop platform has been designed to use shortcuts to speedup navigation and 
order entry. The following table will show you where you can expect to find the icon, and 
what it represents: 
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Name Tab/Page 

 
Function 

 

 Blue Dot 
Monitor, Trade, 
Analyze 

Opens a menu 

 Blue Arrow All Opens a menu 

 Grey Dot 
Market View 
Market Watch/ Quote 

Shortcut to customize your watchlist or 
select a different watchlist 

 Link Boxes 
Market View 
All Tabs/Pages 

Shortcut to link symbols in different 
sections/pages 

 Gear 
Market View 
Market Watch/Quote 

Shortcut to select particular watchlists 

 Detach Icon All 

Opens the section in a separate window 
that can be repositioned on your screen or 
moved onto an extended desktop of 
another monitor 

 Print Icon All Shortcut to Print of Export your page 

 Calendar 

Monitor/ Acct. 
Statement 
Trade/All Products 
Analyze/ Several 

Shortcut for selecting a particular date 

 
 
 

Yellow Flag 
 
Blue Flag 

Multiple pages: black 
background 
Multiple pages: metal 
or white backgrounds 

Opens Dropdown Menus for a information 
column or data field 
Opens Dropdown Menus for an information 
column or data field 

 
 

 

Double Down 
Arrows 

Trade Tab/ All Products 
page 

Opens Symbol Field Table, a listing of 
symbols for indices, futures, forex, etc. 

 
Message 
Center 

Left Side Bar Opens Message Center 



 

 

last updated: 12/17/2009  www.thinkorswim.com/learningcenter 

thinkDesktop User Manual 
support@thinkorswim.com  866 839 1100  

8 

 

III. Main@thinkorswim Layout 
Focus your attention to the upper left hand corner to begin  In this corner you will see the 
“Main@thinkorswim [build xxxx]” for your LIVE account, or you’ll see “Main@paperMoney 
[build xxxx]” for your paperMoney. Take a second to double check this area. If you are just 
learning to use the platform, we, again, recommend that you start with the paperMoney to 
build your familiarity. 

Please note: 

Closing the platform DOES NOT cancel your orders NOR close your positions. 

Please be sure your work is done for your session before you close the platform. Of course, 
if you realize you forgot to take care of something, simply sign back in and take care of it. 

a. Left Side Bar 
Below this banner is the Left Side Bar. This area is available to provide you with some basic 
information which can always be displayed regardless of which main page you are on (we 
will discuss the main pages later). The Left Side Bar is split into 3 sections: 

Account Info 

The Account Info Area provides you with your basic Account information. You can see the 
current date and time, your session status, your active account number, your option buying 
power, and your net liquidating value and day trades. 

 

1. Current Date and Time:  click on the blue arrow to the right to select either your 
local date and time, or the equivalent Eastern Time Zone time (New York time). 

2. Session Status: your status should always read either ‘Connected’ for a funded 
account or ‘Delayed 20 min’ for unfunded accounts. If it says ‘Reconnecting’ then 
something could be  wrong with the internet connection. If your platform doesn’t 
reconnect in about a minute’s time, close your software, check your internet 
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connection, and reopen the program to reestablish connection. You can also click on 
the blue arrow to the right of “Session Status” to change your password. 

3. Active Account: this will display the current account you are viewing. Notice in the 
picture below, the account number begins with a “D-“. This indicates that my 
account is currently a Demo or paperMoney account. You can not toggle between a 
live account and a demo account. They are kept separate on purpose. 

4. Option Buying Power: this will display the amount you may invest in an Options 
position. You can click on the blue arrow to the right of “Option Buying Power” to 
view your Stock Buying Power which factors in your fullest margin capacity in your 
account. 

5. Net Liq. & Day Trades: Net Liquidating Value (Net Liq.) is the current value of your 
account based on the MARK of each asset you have a position in. The MARK for a 
stock is generally the last trade price. The MARK for an option is always the mid 
point between its bid and ask prices.   

Clicking on the Blue shortcut arrow here opens a window showing ther the net 
liquidating values for the five most recent dates.  If you are in a public environment, 
you may also want to click on the Privacy Box to block your account information from 
other curious viewers. 

Hiding the entire Left Side Bar: you’ll notice a blue arrow to the left of ACCOUNT INFO in 
this section. By default it will point down. Click on it. It will point to the right and hide this 
entire section. Please take note of this. Whenever you see a blue arrow you can click on it to 
either open a menu or to expand/collapse a section. Simply click on this arrow again to 
reopen the Left Side Bar. 

You will also notice to the right of ACCOUNT INFO two buttons. One reads ‘Support/Chat’ 
and the other is simply an orange circle with an “!” in it.  

The Support/Chat section allows you to contact live support, visit some TOS sponsored chat 
rooms, manage your audio settings, and/or view archived seminars. Take a moment to 
access this section, say hello to your Live Support by creating a support request, and visit  
the chat rooms:. 

 



 

 

last updated: 12/17/2009  www.thinkorswim.com/learningcenter 

thinkDesktop User Manual 
support@thinkorswim.com  866 839 1100  

10 

 

 

From Time to time, the Trade Desk may need to send you a brief pop-up message, or 
information on one of your pending orders. You can review the message by simply Left 
Clicking on the orange circle to reopen this window. 
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Gadgets 

Gadgets are some simple tools that you’ll hopefully enjoy. There are fourteen choices, of 
which you can have as many windows open as you desire. The blue arrow will open/close 
each window.  To add or remove gadget windows to your desktop, click on the wrench 
following the words Account Info on the top toolbar.  This will cause a small window with a 
GREEN plus sign or a RED slash to appear.  Again, each section is collapsible by clicking on 
the blue arrow to the left of this box. To select your Gadget, click on the white  “Gadgets” 
button to the upper left of this box.  

 

QUICK TIP:  Not only can you choose your gadgets, how many, and their contents, you can 
detach and move the window to another location on your desktop.  Notice to the right 
of this button is another button that looks like two pieces of paper. Click on it. This box will 
duplicate the contents to a separate windows based window. The toolbar will change to a 
lighter shade of blue.  You may detach and re-position the window(s)  You can change the 
gadget on each one for quick access from the bottom Menu bar on your monitor. 
Experiment with this feature  and you’ll quickly catch on to how it works.  Additional 
monitors with extended desktops will allow you to view more information simultaneously.  
There is an archived Wednesday seminar that discusses minimal and advanced technological 
configurations for this platform..   

This screen mobility feature is available for all windows with the 2 sheet icon. 

 QUICK TIP: For those of you who want to follow CNBC commercial free during the day, 
there is a link.   Should you hear a story that you might want to listen to again, you can go 
to the Tools tab to see a list of recent broadcasts.  Additionally, you can enter the symbol of 
a stock and get a listing of all recent stories. 
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Market View 

Many users want an area where they can quickly find current market data.  Market View is 
the name given to this space.  A subset of Gadgets, you can configure it  with your 
personalized watchlists such as indexes, futures, sectors that you follow, etc,. You can click 
on the icon of a gear at the top of each watchlist to change it, or right click on the any one 
of your column headings to customize this list.   You can also have a Quick Quote and Quick 
Chart area where you can quickly type in a symbol without having to go elsewhere on the 
platform.  

 

QUICK TIP:  You can create personal watchlists with stocks and data in each column to 
meet your needs.  Go to the MarketWatch Tab, click on Quote.  On the Upper right toolbar, 
there  is a white box with three icons after the word “Quotes”.  Clicking on the GEAR icon 
will bring up a menu with the Create New Watch List option.  Enter a name and whichever 
items you  want.  Additional instructions for doing this are demonstrated in the Learning 
Center. 

If you don’t care to view these watchlists, simply left click on the blue arrow to hide this 
section. Notice also that this area can also be detached. It can be printed as well. 
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QUICK TIP:  To the right of the accounts tab, are various other tabs that you will need to 
learn.   When engaged, the accounts tab data crowds out other screen space.  You can 
temporarily hide account information by hiding the entire Left Side Bar.  Notice a blue arrow 
to the left of ACCOUNT INFO in this section. By default it will point down. Click on it. It will 
point to the right and hide this entire section. Please take note of this. Whenever you see a 
blue arrow you can click on it to either open a menu or to expand/collapse a section. Simply 
click on this arrow again to reopen the Left Side Bar. 

 

b. Main Window 
The majority of the space on your screen shows the Main Window. This area will be the 
primary section you will use to monitor your account and to enter orders. It is split into 
several sections called “Tabs” which appear horizontally across the top.  

 

While the advanced features of the platform allow the tools on each tab to overlap, for the 
purposes of this manual we will focus on each tab alone.  

Monitor Tab 

The Monitor tab is split into pages: everyone has  the Activity and Positions page and the 
Account Statement page. Traders of the futures and Foreign Exchange (FX) will have those 
pages listed here as well.  Each page is designed to allow you to monitor your account 
status and balance in real time. 
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Monitor Tab > Activity and Positions 

This page will give you a snapshot of your account’s trade activity and positions.  

The top portion is the “Today’s Trade Activity” section. In this section you can view your 
Working orders, Filled orders, and Cancelled Orders. 

 

Notice the blue arrow to the left of Working Orders is pointing down, 
indicating this menu is opened. If it is not, click on it to view any 
working orders. One working order is displayed above.  

Right Clicking anywhere on the order will bring up the Order Menu  
(we are aware that you have not yet placed any orders of your own.)  
The Order Menu is extremely useful.  Its many features are 
demonstrated in the videos on the learningCenter.  

Any canceled order will appear below the Canceled Orders section.  

http://mediaserver.thinkorswim.com/support/learningCenter/tos_learningcenter.html
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The second portion to this page is the “Position Statement.”  
Originally, all trades were grouped by their trading symbol in 
alphabetical order.  Responding to client request to view their 
portfolio by type of trade, a  New Layout feature was 
incorporated.  The toggle between layout types is found on 
the right side of position statement window. 

Additional details are available regardless of layout.  Just to 
the right of the layout toggle is an icon that resembles three 
files stacked on top of each other.  Clicking in this icon will 
produce a display of trading information for each of your 
positions.  Should you choose to view just one item, click on 
the blue dot before an item. 

To view more than one line you can click and drag over multiple positions selecting as many 
as you wish.  RIGHT CLICKING opens the abridged order menu, and (for example) clicking 
on View Trades will show date entered, average prices, current market value and daily P/L.     

Shortcuts can be used to create orders on the Trade tab. 

  

 

Also notice an ORD appears next to the symbol and next to the +500 ETFC shares owned 
(in the paper account). This indicates a working order for ETFC shares. Be sure to always 
double check your working orders. 

 

There are several features that are available in this section. To find out, Right Click on the 
blue arrow next to the stock symbol (or the blue dot next to the position itself). You will see 
a dropdown menu: 
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This Order Menu will allow you to quickly access additional information about your position, 
or create orders for your position. It is the most commonly used shortcut on the TOS Trade 
Desk, so get familiar with it. 

• Create Closing Order: this is a shortcut to create an order on the Trade tab that 
would close your position if filed. You will of course have the chance to modify the 
order before you send it, so practice using this tool. This shortcut WILL NOT cancel 
any previously entered orders, so be sure to always double check if you are working 
any orders already. If so, cancel the old order before entering your new order. 

• Analyze Closing Trade: this will populate your Analyze page with a simulated trade 
(discussed later) so you can see what your overall position would look like if you took 
off (closed) a portion of it. 

• Create Rolling Order: this shortcut will create a diagonal spread order on the Trade 
tab so you may simultaneously close a current position and open a new position in a 
subsequent month and/or different strike. 

• Analyze Rolling Trade: this will show you what your overall position would look like if 
you rolled your position into a subsequent month/strike. 

• Exercise: this will send instructions to the trade desk to exercise a long position. If 
you are trying to exercise a position prior to expiration, just contact the trade desk 
first so they can take a second look at it for you. They may find a way to save you 
some money. 

• Market Depth: this will display the asset’s bid and ask prices from each exchange in 
the Gadgets section of the Left Side Bar. 

• Trade Grid: this will display the asset’s bid and ask prices from each exchange in a 
popup window. 

• View Trades: this will pop up a window that will list all your filled orders for you 
current position. TOS uses First in First out inventory management, so only the most 
opened positions will be displayed. 

• Quick Chart: this will open a small chart for the asset in the Gadgets section of the 
Left Side Bar. 

An advanced feature is the “Switch to New Layout” button at the right of the page. Click on 
it to open the Position Statement in a customizable format. The Learning Center will review 
the features of this advanced tool. 

Please notice you can detach both portions of this window in case you want to customize 
your screens a bit more. 
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Monitor Tab > Account Statement 

This page will allow you to view more detailed and historic information concerning your 
account. Notice on the picture below that a blue arrow appears next to each menu title. 
Click on the blue arrow so it points down to open the menu. 

In the upper left hand corner you will see: 

 

In the upper right hand corner you will see: 

 

To quickly view the account’s history, enter the number of days (up tp 370) to the right of 
your account number and hit ENTER on your keyboard.    

To view all the activity over a specific range of dates, click on the ‘change dates viewed’ 
button and enter your start and end dates. You can even do from expiration Friday to 
expiration Friday. To reset, click the reset button. 

Quick Tip:  For the time period selected, you can choose just one symbol to pull up all 
related trades. 

Please review the LearningCenter’s videos pertaining to this page to watch examples of 
manipulating this data. 
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Trade Tab 

The Trade tab consists of the most advanced trading tools in the industry. At your fingertips 
are Advanced Orders, Algorithmic Orders (based on mathematical calculations), 
Customizable Orders, one click 1st Triggers other orders, etc.  

The Trade tab consists of four pages: the All Products page, the Forex Trader page, the 
Futures Trader page, and the Active Trader page. We will touch on the basics of each of 
these pages. The advanced features of each page are demonstrated in the LearningCenter. 

Trade Tab > All Products 

This page is an expanded and improved version of the original TOS trade page. There are 
currently  6 sections that function separately and together: 

• The Underlying/Futures section (we’ll call it the Underlying section going forward) 

• The Trade Grid 

• The Options Chain 

• The Position Table 

• The Order Entry and Order Queue 

            The Order Book 

The Underlying Section 

 

The upper left hand corner contains the ‘Symbol Field’. Enter the stock, index, or futures 
symbol you are interested in and hit ENTER on your keyboard. TIP: always hit ENTER on 
your keyboard after typing something into the platform. Notice in the picture above GE has 
been entered. 

Directly below the Symbol Field you will see the word Underlying (or FUTURES if you type in 
a futures symbol). Please also notice directly below the word ‘Underlying’ is a blue arrow 
which is pointed down. This indicates that a secondary menu has been opened in this area. 
If your blue arrow points to the right, click on it so it points down.   A second row of 
information will be displayed. 
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The information fields in the top row of this section display: 

• Last X: The last trade price for the asset (or last calculated value for an Index) and 
the exchange that posted the trade 

• Net Change: The change in last price since the close of the previous day. This value 
only updates during regular US trading hours, and may be adjusted to reflect 
dividends or stock splits. 

• Bid X: the published price and the exchange publishing such a price that shows what 
someone is willing to pay for the asset 

• Ask X: the published price and the exchange publishing such a price that shows what 
someone is willing to sell an asset for 

• Size: will contain two numbers. The first number corresponds to the Bid price and is 
the number of shares X 100 that the bid price represents. The second number 
corresponds to the Ask price and is the number of shares X 100 the ask price 
represents. 

• Volume: total number of shares reported traded for the day 

The information fields in the second row of this section display: 

• Yield: the % annual dividend yield for a stock based on the latest announced 
dividend and the current stock price 

• PE: the Price/Earnings ratio based on the current stock price and the latest reported 
company earnings 

• EPS: the earnings per share 

• Div.: the latest announced dividend 

• Div. Freq.: the latest announced dividend frequency for this stock (usually Quarterly, 
but also Semi-Annually and Annually, or another frequency) 

• Div. Date: the latest announced Ex. Dividend date 

• Beta: a calculated value measuring the returns for this stock in relation to the 
market over time 

• P/C Ratio: Put Call Ratio for this particular underlying only. 

• Shares: shares outstanding 



 

 

last updated: 12/17/2009  www.thinkorswim.com/learningcenter 

thinkDesktop User Manual 
support@thinkorswim.com  866 839 1100  

20 

 

Placing a stock order; 

From this section you can create a buy or sell order quite easily. To create a buy order, left 
click on the ASK price. To create a sell order, left click on the BID price. The order you 
create will appear at the bottom of the screen. Order entry instructions are listed in Section 
IV: Order Entry Made Easy. 

The Trade Grid Section: 

 

This section displays the best bid and ask prices from each exchange for an asset. Like the 
Underlying Section’s symbol field, you can type in a symbol and hit ENTER on your keyboard 
to view these quotes. Notice the blue arrow to the left of “TRADE GRID” is pointing down. 
To open this section, left click on it. 

The Trade Grid can be customized to display information in several cells. Please notice the 
picture above has 6 cells displayed in yellow. By default you may have one or three boxes. 
Please click on them and select a different cell. Try again and see what happens.  

The Trade Grid can be a great tool for viewing option quotes from the six major exchanges.. 
In the picture below you see displayed the bid and ask prices for the GE November 2009 
$16 Call: 

  

Please notice the OPRA code is typed into the Symbol Field. Please don’t worry about the 
OPRA code for now, as there is an easy shortcut to automatically populate an option’s OPRA 
code in this area. 

As an advanced feature to this area, you can display a chart, news, and a dashboard 
(among others) cell in this area. To do so, click on the blue dot to the left of the Symbol 
Field and hold the mouse on the word ‘Gadget’, then click on your selection. The 
learningCenter discusses some of these tools in greater detail. 

If your Trade Grid section is taking up too much room on your screen you can Left Click on 
the blue arrow to the left to hide the section. Click on it again to reopen it. 

 



 

 

last updated: 12/17/2009  www.thinkorswim.com/learningcenter 

thinkDesktop User Manual 
support@thinkorswim.com  866 839 1100  

21 

 

The Options Chain: 

This section will display (almost) everything you need to know about an option. Through the 
layout window you have the ability choose preset layouts or to create a personalized 
display.

 

Please refer to the picture above. The GE November 2009 Options are listed. Each month 
will be listed in the following format: 

Month of Expiration – Year of Expiration – Number of Days ‘til the last trading day – Shares 
per contract 

PLEASE NOTE You may notice some options are listed in RED. For example, Bank of America 

has adjusted options which are listed as: .!  The Shares per 
contract is something other than 100. These are called an ‘adjusted’ or ‘modified’ option. 
They result from corporate actions such as splits or mergers.  Avoid trading these if 
possible.  If you find that you have a position like this, please contact the trade desk to 
discuss the best way to manage the position. 

The information on the Call options is to the left, with Puts information on the right. The 
month, year and strike price are listed in the center. Please note the above picture displays 
4 columns on each side. You may left click on the name of each column (except for the bid 
and ask columns which are fixed) to change the field displayed for each option.  

There are limits to how many columns you can crowd onto your screen.   Available screen 
space can be increased by clicking on the down blue arrow in front of the word Account in 
the upper left corner.  You may also detach the page and move it onto another (widescreen) 
monitor.  This is something you will have to explore on your own or with TOS Support. 

In the upper right hand corner you will also see Exchange. Composite is the default.. This 
means you are viewing the best bid and offer from all the options exchanges in this section. 
If you only want to see the quotes from one exchange, click on this and change it. 

The number of strike prices you can view are customizable as well.  On this screen, ‘All’ is 
selected. However if you are just interested in the At the Money strikes you may choose a 
lesser quantity to save on your computer’s memory requirement. 
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The Position Statement: 

 

This section is an abridged duplicate of the Monitor Tab’s Position Statement.  The screen 
only displays the underlying position that you have already typed in the Symbol Field at the 
top left of the page. You can use this section to double check your current position before 
entering any orders. 

Notice to the left of “Position” the blue arrow is pointing down. If yours is pointing to the 
right, simply left click on it to open this section. 

The Order Entry Tools Section: 

This section consists of two sub-sections:  the Order Entry and Order Queue section and the 
Order Book section. These are highly used tools, so please get very familiar with them. 

The Order Entry and Order Queue section appears below. You see  a sell order for the IWM 
calls. (refer to the picture above). It is possible to  modify this order for quantity, acceptable 
price, order type, rules –day or GTC (Good Till Cancelled) and then click on “Confirm and 
Send” in the lower right to proceed with sending the order. 

 

The Order Queue area which will allow you to save orders to enter at a later time. 

The Order Book section will display all your orders for the day with their status. You can also 
configure this section to list only your working orders, your filled orders, or partially-filled 
and working. You can do so directly to the right of “ORDER BOOK”. Notice also you can 
detach this section in case you are working many orders you’d like displayed in one window. 
There is a scroll bar on the right as well. 

 

This example displays an order to sell 500 ETFC @ 5.00 Limit GTC (Good Till Cancelled). 
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Trade Tab > Forex Trader, Futures Trader, Active Trader 

These pages are used mostly for FOREX and Futures trading. They each consist of a trading 
‘dashboard’ where each cell displays the best bid and ask prices for a Currency Pair/Futures 
Contract (you may also enter stock symbols in this section). These pages will also allow you 
to view charts, time/sales and other tools in the same cell as your bid/ask prices. To begin 
creating an order simply click on the BUY or SELL buttons and proceed from there. 

You may view a market depth ladder on these pages which is an advanced order entry tool. 
Examples of order entry from this tool are demonstrated on the learningCenter.  

Analyze Tab 

The Analyze tab holds the most advanced trading tools offered to the retail trading 
community. From this page you can view a graphical representation of your position’s 
profit/loss profile, stress test that profile, view simulated trades before you enter that 
position, or see what your current position would look like if you were to add or subtract 
from it. There are some great videos available on the learningCenter to guide you along the 
way. In addition, many of the OptionPlanet classes will introduce some of the Analyze tab’s 
features. 

 

Analyze Tab > Add Simulated Trades 

This page will look almost identical to the Trade tab’s “All Products” page. The difference 
here is that any order created will simply be virtually added to your position. To add a long 
position, Left Click on the ask price (like you would to create a buy order on the Trade tab). 
To add a short position, Left Click on the bid price (like you would to create a sell order on 
the Trade tab). If you would like to analyze a simulated spread position, Right click on the 
bid or ask and follow the menus.  
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Please have a look at the pictures of a simulated long position: 

  +1 JPM Nov09 46 Call @ .92: 

 

This simulated trade will appear at the bottom of this page (and the Risk Profile page) below 
“Positions and Simulated Trades”: 

 

Notice the padlock next to the price is green and unlocked. This will allow the simulated 
price to float with the market movements. If you want to lock that price in at .89, simply 
left click on it. 
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Analyze Tab > Risk Profile 

The Risk Profile page will display your theoretical Risk/Reward profile for your position or 
simulated trade. Let’s look at the simulated trade below.  

 

Notice under plot lines at the top of this page it reads “+1 @ Expiration”. That will show 
your profit/loss profile at expiration with no time value remaining. The white line is today’s 
date and shows the theoretical P/L with time value to the position. The videos on the 
learningCenter will show you how to manipulate this area. 

Below the graph you’ll see the price slices: 

 

The Price Slices correspond to the dashed vertical lines that appear on the chart. They will 
display the theoretical P/L, and Greeks at the various price levels so you don’t need to type 
in a bunch of prices. The videos on the learningCenter will show you how to manipulate this 
area. 
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Analyze Tab > Probability Analysis 

This page will use the implied volatility of the options to graph a theoretically predicted 
stock range.  

 

You can adjust the dashed red lines to any range you are interested in viewing. Below the 
graph you will see a table displaying the % chance the stock expires between those prices 
on a specific date. This information is beneficial for all option positions, especially vertical 
spreads, butterflies, and condors when you are selecting high probability trades. 

Analyze Tab > Volatility Analysis 

This page graphically displays the Volatility Skew of the implied volatility of an option chain. 
The screenshot below shows the plotted Vol. skews for JPM. Please look to the upper right 
hand corner. You can control which months you wish to view. The June09 and the modified 
Jan10 options have been left unchecked. You can also control the number of strikes you 
wish to view on the chart.  
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Analyze Tab > thinkBack 

This page will display prior stock and option closing prices. You can load a backtrade, 
meaning you can artificially load a position so you can track what your P/L would have been 
had you opened that position on a previous day. The upper right hand corner is your Quote 
Date. Move to the date desired and open the option chains to view the closing bid and ask 
prices. This example reviews the prices for JNJ on Dec 2, 2008: 

 

 

This page works the same as the Trade tab or Add Simulated Trades page. Simply click on 
the ask price to load a long position, or click on the bid to load a short position. You can 
right click on a bid or ask to follow the menus to load a spread. 

Let’s say you are  bearish on JNJ on Dec 2nd and decide to buy a slightly In-the-Money put. 
You pay the ask price of 7.70 (you can change it manually if you think you might have 
gotten filled inside the bid/ask prices). 

 

Notice there is a date to the right of ‘BACKTRADES’. That is your P/L Date. Advance your 
date to see how your trade would have performed. In this example let’s say you are no 
longer bearish on JNJ on Feb. 4th and would have closed the position. You would have lost 
$360: 

 

For your convenience we have also added a graph at the bottom of the page. This will 
display the stock movements on a bar chart (or candlestick) with your thinkback P/L listed 
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on a yellow line chart. Hold the mouse over the different dates to view your theoretical 
Profit or Loss on each date. 

Why do we do this?  With stock it’s easy to determine if you would have made money. With 
options, just because you bought a call and the stock went up a bit doesn’t necessarily 
mean you made money. The stock price is only one input into the option’s price as you can 
test with the Risk Profile page. 

Scan Tab 

The scan tab holds some of selective tools on the platform. By selective,we mean you’ve 
already formed your opinion, now what?  What underlying stocks fit the mold, or what 
option spreads offer you a reasonable risk/reward opportunity? 

 

There are some great videos available on the learningCenter which will provide you with 
some additional information on this Scan tab. 

Scan Tab > Stock Hacker 

Stockhacker allows you to search for underlying symbols which have certain characteristics. 
Search for stocks within a specific price range, Net or % Changes, Dividend Yields, etc. You 
can search through different industry groups by selecting a specific watch list next to 
“Search in”. Once you’ve entered your criteria, click the SEARCH button to populate your 
results. 

Scan Tab > Spread Hacker 

Like stockhacker, spreadhacker will allow you to input various criteria to search for 
opportunities. The results, though, are not specific underlying stocks but are examples of 
option spreads. You can narrow your results to only one type of spread, industry group, 
Implied Volatility levels, or comparative volume (measured by the Sizzle Index). 

Once you have identified a spread you may be interested in, right click on it and select 
“Analyze Duplicate Trade” to view the risk/reward profile to the Analyze tab. TOS generally 
recommends spreads with a 60-70% probability of profit. The higher the probability of profit 
you go, the greater the commissions affect your profitability. The lower the probability of 
profit you go, the greater your risk of max loss. If your chances for success are a coin flip, 
you aren’t really giving yourself any room for error. 

Also be careful about pricing disparities for illiquid options, or if a large dividend is involved. 
If you are unsure about a spread, or something looks too good to be true, consult the TOS 
trade desk. That is what they are paid for. 
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Scan Tab > Spread Book 

Some option exchanges offer electronic option spread order books. That’s a mouthful if you 
aren’t used to the terminology. Basically any order which involves simultaneously trading 
more than one option class is a spread order. Before electronic trading evolved, all option 
spread orders were printed on paper and traded in a pit. Now some exchanges will trade 
them electronically, and ‘work’ unfilled spread orders in their order book. 

TOS lists all our customer’s spread orders on the Spread Book page. You can type in a 
stock’s symbol and hit the ENTER key on your keyboard to search for other customers’ 
spread orders.  

 

 

 

Perhaps you like someone’s idea, and want to join them. Simply Right Click on the order 
and select “Create Duplicate Order”. You’ll be redirected to the Trade tab where you can 
view the order’s information and decide if you want to proceed with the order.  A side trip to 
the Analyze Page is prudent to see if the risk/reward  profile meets you trading rules. 

Maybe you like the complete opposite of that order. Take the other side!  Right click on the 
order and select “Create Opposite Order”.  

Perhaps you aren’t sure what someone is trying to do?  Right click on the order and select 
“Analyze Duplicate Trade”. That will populate the Analyze tab’s Risk Profile page with the 
order for you to view. 

If you decide to use these tools, remember to take the time to double check what they are 
telling you. If you are not sure about a trade, or if something looks funny then contact our 
Trade Desk. Remember TINSNAFL: There Is No Such Thing As a Free Lunch. 
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MarketWatch Tab 

The MarketWatch tab will give you access to several tools including the Quote page, the 
Alerts page, the Watch page and the Rollover Rates page. You can see these pages’ buttons 
displayed horizontally directly below the display of the tabs: 

 

MarketWatch > Quote 

 This page will allow you to access a watchlist, 
but with greater available fields than the Left 
Side Bar. Left Click on the Quote button to 
open this page. A default watchlist will 
populate. Right click on any of the column 
headers and select “Create New Watchlist” to 
create your own list, “Public” to load a public 
watchlist, or “Personal” to load one of your 
previously saved lists. You may also select 
customize to manage the columns that 
appear on this page. 

MarketWatch > Alerts  

This page functions much like the Trade tab, 
but doesn’t send orders to the exchange. 
Instead, you can receive e-mails, or popup 
alerts on your software based on an asset’s 
value. Experiment with this page a bit and you’ll get the hang of it. 

MarketWatch > Watch  

This page will display some critical information that you can use to trade with, including 
dividends, earnings, splits, etc. Be sure to always double check information with a 
company’s website or some full service news providers to confirm this information. By 
default, each section will be closed. Simply click on the blue arrow to the left of the section’s 
name to open the section. You may need to select a watchlist or click the ‘Refresh ‘ button 
to load a section. Open each, one at a time, and explore the features. 

MarketWatch > Rollover Rates 

If you are trading FOREX this page may be of interest for you. At the end of each trading 
day your FOREX position will be rolled to a new ‘opening’ value. This process is known as 
‘marking to the market’ and is done to reflect the different interest rates for each currency. 
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The Charts tab  

The Charts tab consists of 3 pages: The Charts page, the Prophet page, and the Flexible 
Grid page. This manual will focus on the Charts and the Prophet pages. There is a nice video 
available at the learning center focused on the Flexible Grid page. 

Charts > Charts 

This tool is an in-house developed tool by the TOS development team. There are many 
layouts, time frames, drawings and studies available. Begin by typing in the stock’s symbol 
in the upper left hand corner and hitting ENTER on your keyboard. 

Upper Left:  

Your Chart will populate with the latest trade data available for that asset. You will notice in 
the upper right hand corner there is a series of buttons. We are going to focus on the 3 
main buttons (Style, Drawings and Studies) and 3 lesser buttons which are shortcut buttons. 

Upper Right:   

Click on Style to view a dropdown menu. You can change your timeframe by selecting Daily 
or IntraDay and selecting (first) the period you would like the chart to represent and 
(second) the period you would like each bar or candle to represent. Click on Chart Style to 
select from bar, line, candle and other types. Click on Settings for advanced features. 

Click on Drawings to view a dropdown menu. You can select the different drawing tools to 
add to your chart including Price Level, Fibonaccies, Trendlines, etc. Once you have selected 
your drawing, left click and release the mouse button at the point on the graph you would 
like the drawing to begin. Then move your mouse to the next point, left click and release 
and your drawing will appear. Some drawings require more than 2 points, so be sure to click 
the appropriate number of times. 

Click on Studies to add a study to your chart. Quick Study will allow you to add only one 
study which will replace any other study you are viewing. Add study will add another study 
to your chart. You may click on ‘Edit Studies’ to format, modify or delete a study. 

Charts > Prophet 

This tool was designed by Prophet.net, an affiliate of TOS. It’s a great tool which gives a 
little different charting experience than the Charts page. They will both display real time 
quotes for funded accounts and, quite often, each page will grab a good feature from the 
other to make it their own. Click on the Prophet button to open this page. Then type in your 
symbol and either hit ENTER on your keyboard or click “GO” directly to the right. 
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You’ll notice the menus appear horizontally directly below the Prophet button. In addition, 
you can change some of your settings and time frame using the shortcuts directly to the 
right of the “GO” button. Play with this page a bit to get familiar with it. Tim Knight, the 
designer of the Prophet Charts has done a great presentation on this page to showcase its 
features. We recommend you take the time to watch it increase your familiarity with it. 
Please click here to open a Flash file on your webbrowser. 

 

Charts > Flexible Grid 

This is an advanced page which will allow you to customize the space allotted to each chart 
if you are viewing more than one. Jeff Bierman has done a great presentation on this page 
to showcase its features. We recommend you take the time to watch this also. Please click 
here to open a Flash file on your web browser. The first part of the program will relay some 
technology specs which may be relevant to your computer. Feel free to forward past this if 
you are not concerned with it. 

There is also a seminar on the Active Trader page archived on the help page under Trader 
Lounge Seminar Transcripts.  

http://mediaserver.thinkorswim.com/demos/2008/TOSDemoPlayer.html?vidSource=/transcripts/2008/20080507.swf
http://mediaserver.thinkorswim.com/demos/2008/TOSDemoPlayer.html?vidSource=/transcripts/2009/20090415.swf
http://mediaserver.thinkorswim.com/demos/2008/TOSDemoPlayer.html?vidSource=/transcripts/2009/20090415.swf
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Tools Tab 

The Tools Tab will display some of the newer tools on the TOS platform that are not 
necessarily essential to trading, but are really nice to have. These tools will allow you to 
enhance your experience by sharing your ideas on MyTrade, keeping notes/trade journal 
entries on thinklog, watching CNBC archives on the CNBC page, accessing your Investools 
membership (if applicable) on the Investools page, and accessing some FOREX information 
on the FX Trading page. 

 

 

Tools > My Trade 

mytrade is an online community that is supported by thinkorswim’s affiliates. You don’t 
need to run a separate program to access it, simply click on “MyTrade” at the top of your 
screen to automatically sign in and see what people are saying. View someone’s entry, ask 
them questions, or create your own chat topic on this page. There is a nice quick reference 
guide available as soon as you click on this page. So when you’re waiting for the 
unemployment figures to come out before you decide to trade, hop on here and play around 
with it. 
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Tools > thinkLog  

thinklog is TOS’s online journal. Keep track of your thoughts and ideas when you are 
making a trade. If you had automatically created a note from your Order Confirmation 
Dialog window from the Trade tab, you can review it here.  

 

Tools > CNBC  

The CNBC page will allow you to scan for archived news clips from CNBC. Simply type in a 
stock symbol in the upper left hand corner and hit the ENTER key on your keyboard. To 
access a video, double left click on the title and then click the play button at the bottom of 
your screen. 

 

Tools > Investools  

This page will allow you to access your Investools online education membership from the 
trading platform. If you are an Investools student this page will save your Investools 
password so you don’t need to reenter it each time.  

Tools > FX Trading 

Originally FX trading on the platform was done from a separate page. Now, most features of 
the FX trading, as well as advanced order routing can be found on the Trade tab. We 
recommend you use the Trade tab for your order routing needs. 
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To access your FX statements, go to the monitor page and on to the “Statements” sub-tab. 
Select the type of report you would like to view and then enter the time frame you are 
interested in. Click the “Show Report” button to generate your FX report. 

 

 

Help Tab 

The Help tab will include a plethora of support information and material. This includes phone 
numbers, website links, Audio Links to presentations, and some quick reference links to 
some videos. In addition, there is a link to launch the thinkDesktop learningCenter in the 
upper right hand corner. 

 

You can also keep an eye on your computer’s system use on this Help tab. To open this 
page, click on the System button on the row below the tab display. That will open a tool 
that will allow you to graphically your computer’s memory use. If you experience some 
slowness in updating quotes or loading pages, access this tool. If you’re overloading your 
PC’s capacity then you may need to take steps to alleviate this problem. Contact our tech 
support team with the Support/Chat button in the upper left corner of the software, located 
next to “Account Info”. 
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The SETUP Button: 

Since it appears on every page and tab in the platform, the SETUP button merits an 
introduction.  

 

It will always appear in the upper right hand corner. Left click on it to open your Setup 
window.  

 

From this window you can arrange your preferences to make the platform more your own. 
For example, if you are only a stock trader, then you don’t really need to see DELTA, 
GAMMA, THETA, VEGA, so change your ‘Position Main Layout’. Click on the “Order Defaults” 
subtab to adjust your default quantities for your orders. Be sure to use this on paperMoney 
first, then repeat the setup for your Live account when you are ready. 
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IV. Order Entry Made Easy 
This section will teach you the basic logic to order entry on the TOS software platform. The 
best way to familiarize yourself with the platform is to practice these skills on PaperMoney. 
Once you have built your foundation, then increase your knowledge of the platform by 
watching the demos listed on the learningCenter and practicing those skills. If you are 
unsure or confused about a certain aspect of this platform, please don’t hesitate to contact 
the TradeDesk. 

Most order entry is performed on the Trade Tab. The previous section discussed what each 
page of the Trade tab is used for. For basic order entry, we will focus on the All Products 
page. Steps for order entry on the Forex Trader, Futures Trader and Active Trader 
pages are demonstrated in the learningCenter videos. 

The first step in the order entry process is to enter the Underlying asset symbol in the upper 
right hand corner (and hit ENTER on your keyboard). Once you’ve told the platform to pull 
quotes for that symbol, entering an order is just a click away: 
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Stock Orders > Market Order 
 

Buy Stock 
 

Sell Stock 

 
1. Left Click on the Ask price for the 

stock 

2. Your buy order will appear under 
order entry and order queue in green. 

3. Adjust your quantity. (The quantity 
will be positive for the asset you are 
buying.) 

4. Move from left to right, double 
checking stock symbol (If an incorrect 
symbol appears, delete the order and 
begin the process over.) 

5. Notice your order type is LIMIT by 
default. Left Click on Limit and 
change to MARKET. Notice the price 
column will now be blank. 

6. One time only left click on ‘Confirm 
and Send’ 

7. Double check your order. 

8. Left click  ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Left Click on the Bid price for the 

stock 

2. Your sell order will appear under 
order entry and order queue in 
maroon. 

3. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling.) 

4. Move from left to right, double 
checking stock symbol (If an incorrect 
symbol appears, delete the order and 
begin the process over.) 

5. Notice your order type is LIMIT by 
default. Left Click on Limit and 
change to MARKET. Notice the price 
column will now be blank. 

6. One time only left click on ‘Confirm 
and Send’ 

7. Double check your order. 

8. Left click  ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Stock Orders > Limit Order 
 

Buy Stock 
 

Sell Stock 

 
1. Left Click on the Ask price for the 

stock 

2. Your buy order will appear under 
order entry and order queue in green. 

3. Adjust your quantity. (The quantity 
will be positive for the asset you are 
buying.) 

4. Move from left to right, double 
checking stock symbol (If an incorrect 
symbol appears, delete the order and 
begin the process over.) 

5. Confirm the order type is ‘Limit’ and 
enter your price to the left of the 
order. 

6. Change ‘Day’ to GTC under the Rules 
column if necessary. 

7. One time only left click on ‘Confirm 
and Send’ 

8. Double check your order. 

9. Left click  ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Left Click on the Bid price for the 

stock 

2. Your sell order will appear under 
order entry and order queue in 
maroon. 

3. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling.) 

4. Move from left to right, double 
checking stock symbol (If an incorrect 
symbol appears, delete the order and 
begin the process over.) 

5. Confirm the order type is ‘Limit’ and 
enter your price to the left of the 
order. 

6. Change ‘Day’ to GTC under the Rules 
column if necessary. 

7. One time only left click on ‘Confirm 
and Send’ 

8. Double check your order. 

9. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Stock Orders > Stop Order 
 

Buy Stock 
 

Sell Stock 

 
1. Left Click on the Ask price for the 

stock 

2. Your buy order will appear under 
order entry and order queue in green.  
(Please keep in mind this is not a 
buy plus stop order.  This is an 
order to buy stock only after it 
goes up to or above your stop 
price.) 

3. Adjust your quantity. (The quantity 
will be positive for the asset you are 
buying.) 

4. Move from left to right, double 
checking stock symbol (If an incorrect 
symbol appears, delete the order and 
begin the process over.) 

5. Change the order type from ‘Limit’ to 
‘Stop’ and enter your price to the left 
of the order. 

6. Change ‘Day’ to GTC under the Rules 
column if necessary. 

7. One time only left click on ‘Confirm 
and Send’ 

8. Double check your order. 

9. Left click ‘Send’ when you are ready.  
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Left Click on the Bid price for the 

stock 

2. Your sell order will appear under 
order entry and order queue in 
maroon. 

3. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling.) 

4. Move from left to right, double 
checking stock symbol (If an incorrect 
symbol appears, delete the order and 
begin the process over.) 

5. Change the order type from ‘Limit’ to 
‘Stop’ and enter your price to the left 
of the order. 

6. Change ‘Day’ to GTC under the Rules 
column if necessary. 

7. One time only left click on ‘Confirm 
and Send’ 

8. Double check your order. 

9. Left click  ‘Send’ when you are ready.  
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Stock Orders > Buy Order triggers Sell Stop 
 

Buy Stock 
 

Sell Stock 

 
1. RIGHT CLICK on the ask price for the 

stock. 

2. Hold the mouse over ‘Buy Custom’ 

3. Left Click on ‘With Stop’. 

4. You will see two orders appear in the 
Order Entry area. The top order will 
be a green buy order, and the second 
order will be a maroon sell order. 

5. Notice below the orders in the lower 
left ‘Advanced Order’ reads ‘1st trgs 
All’ 

 

 
1. RIGHT CLICK on the bid price for the 

stock. 

2. Hold the mouse over ‘Sell Custom’ 

3. Left Click on ‘With Stop’. 

4. You will see two orders appear in the 
Order Entry area. The top order will 
be a maroon sell order, and the 
second order will be a green buy 
order. 

5. Notice below the orders in the lower 
left ‘Advanced Order’ reads ‘1st trgs 
All’ 

6. Modify each order’s quantity and 
prices/order type as described above. 

7. One time only click on ‘Confirm and 
Send’ 

8. Double check your orders and make 
sure EVERYTHING looks exactly as 
you want it to appear. 

9. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Stock Orders > Buy Order triggers sell OCO Orders 
 

Buy Stock 
 

Sell Stock 

 
1. RIGHT CLICK on the ask price for the 

stock. 

2. Hold the mouse over ‘Buy Custom’ 

3. Left Click on ‘With OCO Bracket’. 

4. You will see three orders appear in 
the Order Entry area.  The top order 
will be a green buy order.  The 
second and third orders will be 
maroon sell orders. 

5. Notice below the orders in the lower 
left ‘Advanced Order’ reads ‘1st trgs 
OCO’ 

6. Modify each order’s quantity and 
prices/order type as described above. 

7. One time only click on ‘Confirm and 
Send’ 

8. Double check your orders and make 
sure EVERYTHING looks exactly as 
you want it to appear. 

9. Left click ‘Send’ when you are ready.  
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. RIGHT CLICK on the bid price for the 

stock. 

2. Hold the mouse over ‘Sell Custom’ 

3. Left Click on ‘With OCO Bracket’. 

4. You will see three orders appear in 
the Order Entry area.  The top order 
will be a maroon sell order.  The 
second and third orders will be green 
sell orders. 

5. Notice below the orders in the lower 
left ‘Advanced Order’ reads ‘1st trgs 
OCO’ 

6. Modify each order’s quantity and 
prices/order type as described above. 

7. One time only click on ‘Confirm and 
Send’ 

8. Double check your orders and make 
sure EVERYTHING looks exactly as 
you want it to appear. 

9. Left click ‘Send’ when you are ready.  
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders: 
Option order entry is mainly performed through shortcuts on the TRADE tab’s “All Products” 
page. You don’t need to type in OPRA codes into the platform to create your option orders. 
Instructions to open the Options Montage section of the “All Products” page are listed in 
the Main@thinkorswim layout section.  

Option Orders > Market Order 
 

Buy Option(s) 
 

Sell Option(s) 

 
1. Left Click on the ASK price for the 

option you would like to buy. 
 

2. Your buy order will appear under 
order entry and order queue in green. 

3. Adjust your quantity. (The quantity 
will be positive for the asset you are 
buying.) 

4. Move from left to right, double 
checking stock symbol, the option’s 
Month and Year of expiry, and the 
Strike price (If an incorrect symbol 
appears, delete the order and begin 
the process over.) 

5. Notice your order type is LIMIT by 
default. Left Click on Limit and 
change to MARKET. Notice the price 
column will now be blank. 

6. One time only left click on ‘Confirm 
and Send’ 

7. Double check your order. 

8. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Left Click on the BID price for the 

option you would like to sell. 

2. Your sell order will appear under 
order entry and order queue in 
maroon. 

3. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling.) 

4. Move from left to right, double 
checking stock symbol, the option’s 
Month and Year of expiry, and the 
Strike price (If an incorrect symbol 
appears, delete the order and begin 
the process over.) 

5. Notice your order type is LIMIT by 
default. Left Click on Limit and 
change to MARKET. Notice the price 
column will now be blank. 

6. One time only left click on ‘Confirm 
and Send’ 

7. Double check your order. 

8. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders > Limit Order 
 

Buy Option(s) 
 

Sell Option(s) 

 
1. Left Click on the ASK price for the 

option you would like to buy. 

2. Your buy order will appear under 
order entry and order queue in green. 

3. Adjust your quantity. (The quantity 
will be positive for the asset you are 
buying.) 

4. Move from left to right, double 
checking stock symbol, the option’s 
Month and Year of expiry, and the 
Strike price (If an incorrect symbol 
appears, delete the order and begin 
the process over.) 

5. Confirm your order type is LIMIT. 
Adjust your limit price to the 
maximum you are willing to pay for 
the option. 

6. Change the order from ‘Day’ to ‘GTC’ 
if necessary. 

7. One time only left click on ‘Confirm 
and Send’ 

8. Double check your order. 

9. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Left Click on the BID price for the 

option you would like to sell. 

2. Your sell order will appear under 
order entry and order queue in 
maroon. 

3. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling.) 

4. Move from left to right, double 
checking stock symbol, the option’s 
Month and Year of expiry, and the 
Strike price (If an incorrect symbol 
appears, delete the order and begin 
the process over.) 

5. Confirm your order type is LIMIT. 
Adjust your limit price to the 
maximum you are willing to pay for 
the option. 

6. Change the order from ‘Day’ to ‘GTC’ 
if necessary.  

7. One time only left click on ‘Confirm 
and Send’ 

8. Double check your order. 

9. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders > Vertical Spread Order: 2 legged order 
 

Buy Option(s) 
 

Sell Option(s) 

 
1. RIGHT CLICK on the bid or ask price 

for the long leg of the spread. 

2. Hold the mouse over BUY -> and left 
click on Vertical. 

3. Your buy order will appear under 
order entry and order queue in green. 

4. Adjust your quantity. (The quantity 
will be positive for the asset you are 
buying and negative for the asset you 
are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. RIGHT CLICK on the bid or ask price 

for the short leg of the spread. 

2. Hold the mouse over SELL -> and left 
click on Vertical. 

3. Your sell order will appear under 
order entry and order queue in 
maroon. 

4. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling and positive for the asset you 
are buying.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders > Calendar Spread Order: 2 legged order 
 

Buy Option(s) 
 

Sell Option(s) 

 
1. RIGHT CLICK on the bid or ask price 

for the short leg of the spread (the 
near term month). 

2. Hold the mouse over BUY -> and left 
click on Calendar. 

3. Your buy order will appear under 
order entry and order queue in green. 

4. Adjust your quantity. (The quantity 
will be positive for the asset you are 
buying and negative for the asset you 
are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. RIGHT CLICK on the bid or ask price 

for the long leg of the spread (the 
near term month). 

2. Hold the mouse over SELL -> and left 
click on Calendar. 

3. Your sell order will appear under 
order entry and order queue in green. 

4. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling and positive for the asset you 
are buying.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders > Butterfly Order: 3 legged order 
 

Buy Option(s) 
 

Sell Option(s) 

 
1. Right Click on the bid or ask price for 

the middle strike (the strike you will 
sell). 

2. Hold the mouse over BUY -> and left 
click on ‘Butterfly’ 

3. Your buy order will appear under 
Order Entry and Order Queue in 
green. 

4. Adjust your quantity. (The quantity 
will be positive for the assets you are 
buying and negative for the asset you 
are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Right Click on the bid or ask price for 

the middle strike (the strike you will 
buy). 

2. Hold the mouse over SELL -> and left 
click on ‘Butterfly’ 

3. Your sell order will appear under 
Order Entry and Order Queue in 
maroon. 

4. Adjust your quantity. (The quantity 
will be negative for the asset you are 
selling and positive for the assets you 
are buying.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders > Call Condor: 4 legged order  
 

Buy Option(s) 
 

Sell Option(s) 

 
1. Find the bid and ask prices for the 

second lowest striked leg you are 
interested in. 

2. RIGHT CLICK on the bid or ask price, 
hold the mouse over BUY -> and left 
click on ‘Condor’ 

3. Your buy order will appear under 
Order Entry and Order Queue in 
green. 

4. Adjust your quantity. (The quantity 
will be positive for the assets you are 
buying and negative for the assets 
you are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Find the bid and ask prices for the 

second lowest striked leg you are 
interested in. 

2. RIGHT CLICK on the bid or ask price, 
hold the mouse over SELL -> and left 
click on ‘Condor’ 

3. Your sell order will appear under 
Order Entry and Order Queue in 
maroon. 

4. Adjust your quantity. (The quantity 
will be positive for the assets you are 
buying and negative for the assets 
you are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders > Put Condor: 4 legged order 
 

Buy Option(s) 
 

Sell Option(s) 

 
1. Find the bid and ask prices for the 

second highest striked leg you are 
interested in. 

2. RIGHT CLICK on the bid or ask price, 
hold the mouse over BUY -> and left 
click on ‘Condor’ 

3. Your buy order will appear under 
Order Entry and Order Queue in 
green. 

4. Adjust your quantity. (The quantity 
will be positive for the assets you are 
buying and negative for the assets 
you are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Find the bid and ask prices for the 

second highest striked leg you are 
interested in. 

2. RIGHT CLICK on the bid or ask price, 
hold the mouse over SELL -> and left 
click on ‘Condor’ 

3. Your sell order will appear under 
Order Entry and Order Queue in 
maroon. 

4. Adjust your quantity. (The quantity 
will be positive for the assets you are 
buying and negative for the assets 
you are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Option Orders > Iron Condor: 4 legged order 
 

Buy Option(s) 
 

Sell Option(s) 

 
1. Start with the Call you want to buy 

2. RIGHT CLICK on the bid or ask price 
for that call, hold the mouse over 
BUY-> and left click on ‘Iron Condor’ 

3. Your buy order will appear under 
Order Entry and Order Queue in 
green. 

4. Adjust your quantity. (The quantity 
will be positive for the assets you are 
buying and negative for the assets 
you are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. Pay close attention that 
the negative quantities match the 
legs you are selling and positive for 
the legs you are buying. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 

 
1. Start with the Call you want to sell 

2. RIGHT CLICK on the bid or ask price 
for that call, hold the mouse over 
SELL-> and left click on ‘Iron Condor’ 

3. Your sell order will appear under 
Order Entry and Order Queue in 
maroon. 

4. Adjust your quantity. (The quantity 
will be positive for the assets you are 
buying and negative for the assets 
you are selling.) 

5. Move from left to right, double 
checking stock symbol, and adjust 
the options’ Month and Year of 
expiry, and the Strike prices if 
necessary. Pay close attention that 
the negative quantities match the 
legs you are selling and positive for 
the legs you are buying. 

6. The default order type will be LIMIT. 
Change that if necessary. 

7. Enter your price. 

8. Change ‘Day’ to ‘GTC’ if necessary. 

9. One time only left click on ‘Confirm 
and Send’ 

10. Double Check your order. 

11. Left click ‘Send’ when you are ready. 
If you would like to edit the order, 
left click ‘Edit’ instead of ‘Send’ 
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Quick Definitions: 
Vertical Spread: also known as a “Credit Spread” or a “Debit Spread”.  

• If you sell a Vertical spread to open a position, that is also called a “Credit Spread”. 
If you sell a Vertical Call spread to close a position, that is simply closing a “Debit 
Spread” position. 

• If you buy a Vertical spread to open a position, that is also called a “Debit Spread”. If 
you buy a Vertical Call spread to close a position, that is simply closing a “Credit 
Spread” position. 

Calendar Spread:  also known as a “Time Spread” 

• Generally retail traders will buy Calendar spreads to open a position.  

• Generally retail traders will sell Calendar spreads to ‘roll’ their short leg into the next 
month. 

Butterfly Spreads: 

• If you Buy a butterfly, you want the stock to close at the short strike on expiration 
for max profit. You have bought a vertical spread which you want to expire at max 
value, and you’ve sold a vertical spread which you want to expire worthless. Be sure 
to close the position before expiration to avoid exercise/assignment. 

• If you Sell a butterfly, you want the stock to close above or below ALL the strikes for 
max profit. The credit you received from selling the vertical was greater than the 
debit you paid to buy the other vertical spread. You either want them both to expire 
worthless to keep that credit, or you want them both to expire at max value 
(assuming a standard butterfly position)  You may want to close the butterfly before 
expiration to avoid expiration fees on ITM options. 

Condor Spreads: condors are similar to butterflies, but provide some extra “room” in the 
middle of the strikes. As a result, their premium is higher than a corresponding butterfly. 

• If you buy a condor you want the stock to close between the short strikes on 
expiration for max profit. Be sure to consider closing the ITM positions to avoid 
exercise/assignment and/or expiration fees on TIM options. 

• If you sell a condor you want the stock to close outside of all the strikes on 
expiration for max profit. You may want to close the butterfly before expiration to 
avoid expiration fees on ITM options. 
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Iron Condor Spreads: Iron Condors are similar to Condors, but with an inverse risk/reward 
profile. This means: 

• When you buy an Iron Condor, you are buying a Vertical Call spread and buying a 
Vertical Put spread. You will achieve max profit when one of the spreads expires ITM 
at max value. You will achieve max loss when both of the spreads expire OTM, and 
lose your investment. As a result, Buying an Iron Condor is the same as selling a 
Condor:  you want the underlying to close OUTSIDE of the strikes. 

• When you sell an Iron Condor, you are selling a Vertical Call spread and selling a 
Vertical Put spread. You will achieve max profit when the stock closes between the 
short strikes, leaving both spreads worthless. You will achieve max loss when the 
stock closes outside of the strikes, leaving one of the sold credit spreads at max 
value. As a result, Selling an Iron Condor is the same as buying a Condor: you want 
the underlying to close between the short strikes. 

V. Laws of paperMoney 
PaperMoney is a simulation of the market. As such, you will notice some inconsistencies 
between how your paperMoney filled your orders and how the live exchange filled your 
orders.  

You may use PaperMoney for several goals including practicing using the platform’s tools, 
practicing your trading strategy, to learn about advanced order entry tools before employing 
them in your live account. You will notice that the performance of your PaperMoney account 
will differ from your live account. There are several reasons for this, which will be explained 
below: 

Laws of the simulation: 

Any order may be filled only during regular US trading hours. 

All orders are filled at the MARK: the value of the asset. For stock and futures the MARK is 
generally the last trade price. For options the MARK will be the average between the bid and 
ask. 

Options are only exercised at expiration, never early. 

Dividends and other corporate actions are not applied on PaperMoney. 

These sound pretty simple. However, these may affect the fills in your PaperMoney account 
so that your portfolio’s performance may or may not be accurate to what it would have been 
in real lift. Also, keep in mind that users have found that PaperMoney is more of a game and 
have been able to stay objective. Once live money is put at risk, however, some investors 
have found that their trading strategy needs to be adjusted.  

Here are some ramifications of the simulation (this list is not exclusive): 
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As soon as US market hours open, your order may be filled at the MARK. In real life, the 
exchange may not open trading on that product exactly upon the open of the markets. Very 
often there may be a delay in the opening of that product at the primary exchange even 
though the stock may be trading on a secondary exchange. This can cause an inaccurate fill 
price. 

Filling at the MARK ignores liquidity. The less liquid an asset is, the more value you will have 
to give up in real trading to be filled.  

In the event of wide bid/ask spreads, a fill price may be unrealistic. This is common for 
spread trading in SPX, and other products that have wide prices. Focus on liquid products in 
well known companies while refining your techniques. When you switch to live trading, stay 
with those liquid companies. If you choose to switch to less liquid products, cut back your 
size and work LIMIT orders to try to fill as close to the MID as possible. Get to know how 
these behave before increasing your size. 

Early exercise of ITM options is most common when dividends are involved, or when puts 
are deep in the money and have no time value. For spread trading focus on Out of the 
Money options. Don’t sell Deep In the Money Put Vertical spreads, as buying Deep Out of 
the Money Call Vertical spreads generate the same risk/reward profile. If you are buying 
calendars, select Out of the Money options, not ITM. 

 

VI. Lessons and Playbook 
 We have additional information about option trading strategies available on our website. 

VII. Glossary 
Any self-respecting option trader knows that "abandonment" is a God-given right, not 
punishable by law. Trading has a language of its own, and the sooner you master it, the 
better you can ask for what you really want. For your convenience, we've compiled a 
glossary with a decidedly option-oriented outlook (minus the four-letter words) here on our 
website. 

https://www.thinkorswim.com/tos/displayPage.tos?webpage=trainingProducts
https://www.thinkorswim.com/tos/displayPage.tos?webpage=dictionary
https://www.thinkorswim.com/tos/displayPage.tos?webpage=dictionary


 

The risk of loss in trading securities, options, futures and forex can be substantial. 
Customers must consider all relevant risk factors, including their own personal financial 
situation, before trading. Options involve risk and are not suitable for all investors. See the 
Options Disclosure Document: Characteristics and Risks of Standardized Options. A copy 
can be requested via email at support@thinkorswim.com or via mail to 600 W. Chicago Ave., 
#100, Chicago, IL 60654-2597. Trading foreign exchange on margin carries a high level of 
risk, as well as its own unique risk factors. Forex investments are subject to counter-party 
risk, as there is no central clearing organization for these transactions.  Please read the 
following risk disclosure before considering the trading of this product: Forex Risk Disclosure. 
thinkorswim is compensated through a portion of the forex dealing spread. Funds deposited 
into an account with a broker-dealer for investment in any currency, or which are the 
proceeds of a currency position, or any currency in an account with a broker-dealer, are not 
protected by the Securities Investor Protection Corporation (SIPC). 
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